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A

Legal notice



Copyright and trademark information relating to this product release.

Copyright © 2000–2024 RWS Holdings plc. All rights reserved.

This legal notice applies to RWS Holdings plc and its subsidiaries and affiliates. All intellectual
property rights contained herein are the sole and exclusive rights of RWS. All references to
RWS shall mean RWS Holdings plc and its subsidiaries and affiliates details of which can be
obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by RWS. Except as otherwise expressly permitted hereunder
or in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of RWS.

Trados Studio is a registered trademark of RWS. All other trademarks are the property of
their respective owners. The names of other companies and products mentioned herein may
be the trademarks of their respective owners. Unless stated to the contrary, no association
with any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ”  on page 27 .

Although RWS takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS shall not be liable in contract, tort (including
negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or
damage of any kind or arising out of, or in connection with, the use or performance of the
Software Documentation even if such losses and/or damages were foreseen, foreseeable or
known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual
or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of
business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or
consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." RWS makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
for any purpose, without the express written permission of RWS.
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1

Introducing Trados Studio
2024



This chapter gives you an overview the of Trados Studio client installation procedure and
the Trados Studio 2024 system.

About this guide
This guide describes how to install and license Trados Studio 2024 desktop application.

This guide does NOT cover:

• Installing the server components of Trados Studio 2024.

• Installing the MultiTerm 2024 application.

• Converting or upgrading existing translation resources to use with Trados Studio 2024.

• Using Trados Studio 2024.

Audience for this guide
This guide is for anyone who is installing any edition of Trados Studio 2024 on a personal
computer.

Related documentation
• Trados Studio 2024 Migration Guide - contains information about converting or

upgrading existing translation resources from SDL Trados 2007 and SDLX so that you
can work with them in Trados Studio 2024.

• Trados GroupShare 2020 SR1 Installation Guide - contains information about installing
the server components of Trados Studio 2024 and upgrading server-based translation
memories from Trados Studio 2009 to the 2024 format.

• Trados Studio 2024 Help - contains information about using Trados Studio 2024.

• Translating and Reviewing Documents Quick Start Guide - contains information for
translators and reviewers. It focuses on how to translate and review files.

• Project Management Quick Start Guide - contains information for project managers. It
focuses on the project lifecycle.

• Translation Memory Management Quick Start Guide - contains information for users
who create and maintain translation memories.

• MultiTerm 2024 Installation Guide - contains information about installing MultiTerm
2024.
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About Trados Studio
Trados Studio is an integrated environment that enables translation teams to share
translation tools, resources and project files.

Resources such as translation memories can be shared over an intranet or over the Internet.

You can also use Trados Studio as a single-user tool where the Trados Studio software and
translation memories are located on your computer and there is no interaction with
translation memories or projects over an intranet or the Internet. Single-users can open
and work with project packages created in other Trados Studio installations.

About Trados Studio 2024
Trados Studio 2024 contains tools that enable you to:

• Create and manage translation projects, including cloud projects.

• Create and maintain local and server-based translation memories.

• Open documents and translate them.

• Open server-based and local translation memories and apply them to documents.

• Open local and server-based termbases and apply them to documents.

• Update translation memories and termbases during translation.

• Align existing translated documents to generate translation memory content.

In a setup that includes server components, Trados Studio client communicates with server
components through an intranet (through a LAN or WAN) or through the Internet using
Trados GroupShare. Trados GroupShare includes the following components:

• Project Server

• TM Server

• MultiTerm Server

Licensing
When you purchase any RWS software, you must activate it before you can use it. Activation
means that the product is licensed for use on the machine where it is installed.

Trados Studio 2024 uses the following license types:

Single-user license

You can perform online activation with this type of license using an activation code. You can
download the activation code from the My Account area on the RWS website when you
purchase the software or at a later date. If you do not have access to the Internet on the
computer where you have the software installed, you can still activate your product using
offline activation.

Network license

1Introducing Trados Studio 2024
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The administrator performs activation using an activation code on a license server, on a
shared network. You can then connect to the server and request a license.

Subscription license

You can also activate Trados Studio 2024 and later with a subscription license available for
one of the following RWS cloud offerings:

• Trados Enterprise

• Trados Team

• Trados Accelerate

• Trados Studio's cloud capabilities

A Trados Studio subscription provides an alternative to permanent licenses and includes
built in cloud capabilities with the following benefits:

• access to cloud projects

• lower entry price and the ability to pay-as-you-go

• guaranteed updates

Trial license
Trados Studio 2024 includes a 30-days trial license.

Available features
During the product's trial period, you can try all the features that the full-fledged edition of
that product has to offer (for example the Trados Studio Professional edition).

After the trial period expires, if you decide to purchase another edition of the product that
better suits your needs (for example the Trados Studio Starter edition), bear in mind that
some of the features available in the Trial Mode will not be available after you activate your
license.

For more information about the differences between the available Trados Studio editions,
consult this link: Trados Studio editions comparison table .

Product activation during the trial period
To continue using the product after the trial period expires, you must purchase a permanent
or subscription licence from the RWS Website and then activate your product.

If you are using a trial license and you want to switch to an activate license, open the Help
tab > Product activation and choose the Perpetual License or Language Cloud
Subscription tab. If you activate your product during its 30-day trial period and then
deactivate the license, you will be able to continue using the product for the remaining trial
period.

1 Introducing Trados Studio 2024

4 Installation Guide

https://docs.rws.com/TradosStudio/TradosEditions


Activating your product
To learn how you can activate Trados Studio, read the instructions from the Licensing Help .

Trados Studio editions
Starting with Trados Studio 2024, you can also activate Trados Studio either with a perpetual
or a subscription license. For organizations whose translation team needs to scale rapidly
or have varying workloads, purchasing Studio 2024 licenses on an annual subscription may
be the best option. Other companies who may prefer to fix their costs at the outset may
prefer to opt for perpetual licenses.

Perpetual licenses
With a perpetual license, the initial cost may be higher. However, the license does not expire
and you own the software outright, meaning you may use it for many years to come.

You will receive updates and service releases for Studio 2024 for as long as RWS supports
the version. Should you wish to upgrade to future editions of Studio, you'll need to pay for the
upgrade.

Access to RWS Support is available through a Support and Maintenance Agreement (SMA) at
an additional cost.
Subscription licenses

When you purchase an annual subscription for Trados Studio 2024, the initial cost may
often be lower. However, you do not own the software outright, and access to the software
is for the duration of your subscription. During your subscription, you will receive updates
and service releases. You'll also receive upgrades to future editions of Trados Studio,
ensuring you continue to benefit from the new functionality and enhancements when
released.

With a subscription, you will have the flexibility to easily add extra licenses for new team
members and also cancel at the end of your contract. Access to RWS Support is available at
an additional cost.

Subscription plans
The following subscriptions are available to meet the different needs of freelance translators,
Language Service Providers and corporate or government customers:

1Introducing Trados Studio 2024
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Subscription type Availability Cloud benefits

Cloud capabilties for
Trados Studio Freelance

Free with Trados 2024 Freelance
and Freelance Plus • Cloud storage and

resources
• Access to the Online

Editor
• Web project

Dashboard
• Access to Trados

mobile app

Cloud capabilties for
Trados Studio Profes-
sional

Free with Trados 2024 Professional
and Professional Network (one
Trados subscription for every
network license)

Trados Team Trial available here , or purchase
from your Sales representative

All benefits + sharing
capabilities

Trados Translation
Management System

Purchase from Sales
representatives

Custom translation
management solution

Trados Accelerate Trial available here , or purchase
from your Sales representative

Out-of-the box translation
management solution

For more information, see Cloud offerings and subscriptions in the online Help.

Perpetual licenses

When you purchase a perpetual license for Studio 2024, the initial cost may be higher.
However, the license does not expire and you own the software outright, meaning you may
use it for many years to come.

You will receive updates and service releases for Studio 2024 for as long as RWS supports
the version. Should you wish to upgrade to future editions of Studio, you'll need to pay for the
upgrade. Access to RWS Support is available through a Support and Maintenance Agreement
(SMA) at an additional cost. The following perpetual licenses are available:

• Professional

• Freelance

• Starter

• Express

• Workgroup

Professional
Trados Studio Professional is the complete package that includes all available features.

If you are also working with Trados GroupShare the server component of Trados Studio, this
edition gives you project manager functionality designed for use in GroupShare
environments.
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Freelance
Trados Studio Freelance is limited in the following ways:

• You can only work with three target languages. However, you can open, translate and
create projects in any language. Any new multilingual project that you create can include
up to three target languages. If you need to use more than three target languages,
create separate projects.

• You cannot use Trados Studio Freelance on a computer that is part of a domain-based
corporate network.

• You can open and work with project packages, but you cannot create them.

• You can add and edit translation quality assessments, but you cannot create a Translation
Quality Assessment configuration for a project.

• You cannot create custom task sequences.

• You cannot apply PerfectMatch to project files.

• You cannot publish GroupShare server-based projects.

Starter and Express
Trados Studio Starter and Trados Studio Express both have similar functionality to Freelance.

What you can do in Starter and Express depends on which workflow you are using. The
following list shows the key tasks that you can perform in each workflow. Express also allows
you to run Studio as part of a domain-based corporate network and have use of an unlimited
number of languages.

Features Express Starter Freelance Workgroup Professional

Single file translation

Unlimited
language
support

- - Up to three
target
languages
for new
projects

YES YES

Single file
translation -
all file
formats

NO YES YES YES YES

Create
file-based
TMs

NO NO YES NO YES
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Features Express Starter Freelance Workgroup Professional

Unlimited
file-based TM
size

NO
*unlimited
when
receiving
packages

NO
* 5,000
Translation
Units (app.
50,000
words) for
single file
translation;
unlimited
when
receiving
packages

YES YES YES

Open
multiple TMs
at a time

NO NO YES YES YES

Open
unlimited
termbases

YES
*only if part
of a package

YES
*only if part
of a package

YES YES YES

Open local
project

NO NO YES YES YES

Multiple file/ language translation

New project
wizard

NO NO YES NO YES

Full batch
task
functionality

NO NO YES NO YES

Custom task
sequences

NO NO NO YES YES

SDL Package support

Create SDL
Packages

NO NO NO YES YES

Email SDL
Packages

NO NO NO YES YES

Open SDL
Packages
from Profes-
sional
version
without
restrictions

NO YES YES YES YES

1 Introducing Trados Studio 2024
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Features Express Starter Freelance Workgroup Professional

Open SDL
Enterprise
Systems -
Packages
(TMS,
WorldServer*).
* To work
with
WorldServer
packages,
first install
the
WorldServer
Compatibility
Peck from
the RWS
AppStore

YES YES YES YES YES

Trados GroupShare integration

Open
server-based
project

NO YES YES YES YES

Publish to
Trados
GroupShare
(project
server)

NO NO NO NO YES

Productivity features

upLIFT
Fragment
Recall

- YES YES YES YES

upLIFT Fuzzy
Repair

- YES YES YES YES

Upgrade
legacy TM
formats*
*Requires
the Trados
Compatibility
and
Migration
Power Pack
from the
RWS
AppStore

YES NO YES NO YES

Upgrade TM
from target
file

NO NO YES YES YES

RevleX TM
engine

NO YES YES YES YES
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Features Express Starter Freelance Workgroup Professional

Translation
Quality
Assessment
(TQA)

YES, but
disabled by
default

YES, but
disabled by
default

YES, but
disabled by
default

YES YES

QuickPlace - YES YES YES YES

Real-time
preview

- YES YES YES YES

AutoSuggest
- Use and
Create

YES YES YES YES YES

PerfectMatch
- Use and
Create

YES, but
disabled by
default

YES, but
disabled by
default

YES, but
disabled by
default

YES YES

Access
machine
translation
from the tool

YES NO
*unless the
MT string is
provided in
an Trados
Studio
package

YES YES YES

TM
maintenance

NO NO YES NO YES

Import TMX
translation
memories
* Requires
the Trados
Compatibility
and
Migration
Power Pack
from the
RWS
AppStore.

NO YES YES YES YES

Align files NO NO YES YES YES

Creation of
termbase
(add/edit
terms)

NO NO YES YES YES
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Features Express Starter Freelance Workgroup Professional

Use
server-based
TMs

YES
*requires
SDL Trados
Studio 2017
or higher

YES
*only if they
are referred
to inside an
Trados
Studio
package or
used as part
of a
published
Trados
GroupShare
project

YES YES YES

Update from
reviewed
target file
(Retrofit)

NO NO YES NO YES

Reports view NO NO YES YES YES

Environment

Works on
company
networks
(domain-
based)

NO NO NO YES YES

Apps from
RWS
AppStore

NO NO YES YES YES

Software
Development
Kits

NO NO YES YES YES

Includes
MultiTerm

NO NO YES YES YES

Alignment
based TM
creation

NO - YES YES YES

License-related

License type PERPETUAL PERPETUAL PERPETUAL
and
SUBSCRIPTION

PERPETUAL PERPETUAL and
SUBSCRIPTION

RWS Support
Available

NO NO YES YES YES
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Workgroup
If you are working with GroupShare, the server component of Studio, the Trados
StudioWorkgroup edition gives you functionality designed for use in GroupShare
environments.

Other standard Studio functionality is available with the following limitations:

• You cannot create new projects.

• You cannot publish projects to GroupShare.

• You cannot perform TM maintenance in Translation Memories view in Trados Studio.

Upgrade and Compatibility
Information

Information for upgraders
If you currently have a previous version of Trados Studio installed, you do not need to
uninstall them before installing Trados Studio 2024.

The new version of the software will be installed side-by-side with previous versions of the
software.

If you want to install Trados Studio 2022 and Trados Studio 2024 on the same computer,
make sure that you install the 2022 version first.

Trados Studio project and package compatibility
All versions of Trados Studio 2024, 2022, 2019 and 2017 have the same project and package
format.

Translation Memory Compatibility

Software
Trados Studio 2024 can connect to SDL TM Server 2017-2020.

1 Introducing Trados Studio 2024

12 Installation Guide



Server-based translation memories
You can use server-based translation memories created in SDL TM Server 2017-2020 directly
in Trados Studio 2024.

You can use server-based translation memories created in SDLX Server, SDL TM Server 2007
or earlier versions of this product in Trados Studio 2024 if you first convert them to the
current format. To do this, use the Upgrade Translation Memories wizard in Trados Studio.
For more information, see the Trados Studio 2024 Migration Guide .

Local (file-based) translation memories
You can use local translation memories that were created in SDL Trados 2007, SDLX 2007 or
earlier versions of these products in Trados Studio 2024 if you first convert them to Trados
Studio 2024 format. To do this, use the Upgrade Translation Memories wizard in Trados
Studio. For more information, see the Trados Studio 2024 Migration Guide .

MultiTerm compatibility

Software
Trados Studio 2024 is compatible with any 2017-2021 version of MultiTerm Desktop.

Trados Studio 2024 can connect to 2017-2020 versions of MultiTerm Server.

Note: Depending on which edition of Trados Studio 2024 you purchased, MultiTerm 2024
may be included in the purchase. However, it is not installed automatically. If you want to
install MultiTerm 2024, you must run the MultiTerm 2024 installer. For more information, see
the MultiTerm 2024 Installation Guide .

Server-based termbases
You can use server-based termbases that were created in MultiTerm Server 2017-2020
directly in Trados Studio 2024.

Local (file-based) termbases
If you have access to termbases from any version of MultiTerm 2017-2024, you can work
with them in Trados Studio 2024.

You can search termbases, insert term translations into documents, add new terms to
termbases and edit or delete termbase entries.

Local termbases created in MultiTerm 2009, SDL MultiTerm 2007 (7.5 and 7.x releases) or
MultiTerm iX (version 6.x) can also be used in Trados Studio 2024, but they must first be
converted to Trados Studio 2024 format.
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When you select a termbase from a version previous to SDL MultiTerm 2009 SP3/SP4 in
Trados Studio 2024, you are asked if you want the termbase to be converted to MultiTerm
2024 format. When a termbase is converted, the converted termbase file overwrites the
original termbase in the same location.

Note:

• Once a termbase has been converted to MultiTerm 2024 format, it cannot be reverted
to an earlier format.

• If you want to work with SDL MultiTerm 2009 (1.0, SP1, SP2), SDL MultiTerm 2007 or
MultiTerm iX termbases in Trados Studio 2024 and you also want to be able to open the
termbases in the original MultiTerm application, create copies of the termbases before
you open them in Trados Studio 2024.
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2

Installing Trados Studio 2024



This chapter contains all the information you need to install Trados Studio 2024.

It describes the hardware and software requirements for running Trados Studio 2024 and
provides a step-by-step guide to installing Trados Studio 2024.

Overview
This chapter describes the system requirements and installation steps for Trados Studio
2024.

System requirements
To install and run Trados Studio 2024 you need:

Hardware requirements
• A Microsoft Windows-based PC or an Apple Mac computer running Windows as an

operating system

• Up to 2.5 GB of available disk space to run the Trados Studio 2024 installer

• 2 GB of available disk space to run Trados Studio

• A 32-bit (x86) or 64-bit (x64) processor

• 32-bit (x86) OS

• 1 gigahertz (GHz) or faster processor

• 8 GB RAM

• A screen resolution of 1280x1024 pixels and 256 colors or higher

• 64-bit (x64) OS

• A recent processor with dual or multi-core technology

• 8 GB RAM

• A screen resolution of 1280x1024 pixels and 256 colors or higher

Operating systems

Operating Systems
Supported OS

• Trados Studio 2024 runs on the latest build of Windows 11 and Windows 10

• Trados Studio also supports Windows Server 2022 and Windows Server 2019. As a
general rule, Trados Studio tries to support the operating systems officially supported
by Microsoft.

Unsupported OS
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Trados Studio does not support earlier operating systems such as:

• Windows 8

• Windows 7

• Windows Vista

• Windows XP

• Windows 2003 Server

Recommended OS

RWS recommends that you use Windows 11 or 10 because they are the current and best
supported OS from Microsoft.

Supported server operating systems
Trados Studio can run on the following server operating systems:

• Windows Server 2019

• Windows Server 2022

Software and Internet browsers

Internet Browser
• The new Welcome tab with drag-and-drop capabilities introduced in Trados Studio 2024

is only available on PCs with Microsoft Edge.

• On PCs with Microsoft Internet Explorer 9 or earlier, the old Welcome tab content is
displayed.

Trados Studio Help
The Trados Studio Help buttons are context sensitive and redirect to the online deliverable
on the RWS Documentation Center. This means that to get access to the latest updated help
for Trados Studio you need an Internet connection and one of the following Internet
browsers installed

• Microsoft Edge

• Google Chrome (latest version)

• Mozilla Firefox (latest version)

• Safari 7 and later

If you need to consult the full product documentation in a location with no Internet access,
you can download the WebHelp documentation deliverable, a ZIP file containing all the
documentation as static Web pages.

To download the ZIP file, access the following link: Trados Studio 2024 full documentation as
WebHelp deliverable . Unpack this ZIP file in a location of your choosing and open index.html
in an Internet browser.
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Please note that the documentation may be subject to change after the product has been
released. The live documentation resource at https://docs.rws.com/TradosStudio2024 is
always the most up-to-date resource.

Digital certificate requirements
All Trados Studio code and installer files are digitally signed.

Make sure your list of approved root certificates is up-to-date and includes the root certificate
from the Certification Authority that generates SDL's code signing certificate. At the time of
writing, Studio require DigiCert Assured ID Root CA and DigiCert Assured ID Code Signing
CA-1.

• For computers with access to the Internet, go to https://www.digicert.com and add the
new root certificate to your Trusted Root Certification Authorities certificate store. This is
only available for computers running on operating systems supported by Microsoft
(Windows Vista or later).

• For computers in a locked down corporate environment without access to the Internet,
follow the instructions available at https://technet.microsoft.com/library/dn265983.aspx
 You can also download the specific root certificates directly from
https://www.digicert.com/digicert-root-certificates.htm and apply the certificates to
each locked down workstation manually or by group policy.

Upgrading from an Earlier Version of Trados
Studio
You do not have to uninstall an earlier Trados Studio version before installing Trados Studio
2024.

About the Trados Studio 2024 installer
The installer for Trados Studio 2024 contains the following items:

Included with the installer

• Trados Studio 2024

• MultiTerm 2024 settings including MultiTerm 2024 Core. These enable you to work
with MultiTerm termbases without having MultiTerm Desktop installed.

Note: MultiTerm Desktop 2024 is not included in the Trados Studio 2024 installer. For
more information, see the MultiTerm 2024 Installation Guide .

• S-Tagger for FrameMaker and S-tagger for QuickSilver framework. These conversion
tools enable you to prepare FrameMaker 7 MIF files and Interleaf IASCII files for
translation with SDL Translator's Workbench, SDL TagEditor and Word. To enable these
two conversion tools, install the Trados Compatibility and Migration Power Pack after
installing Trados Studio. This is a free app that you can add from the Add-Ins tab >
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RWS AppStore. After installing the app, launch the S-Tagger components from File >
Legacy DTP Formats.

Prerequisite software
For Trados Studio 2024 to work, there are a number of other pieces of software that need to
be present on your computer. Most of these are also used by other applications and you
probably have them already. However, if they are not present, they will be installed
automatically. A complete list of the prerequisite software is given below.

Prerequisite software
The Trados Studio 2024 installer will install the following software, if it is not already present
on your computer:

• Microsoft .NET Framework 4.8

• Microsoft Visual C++ 2022 Redistributable

• Trados Studio 2024 fully supports all Microsoft Office 2007-2019 and 2000-2003 file
formats. You may want to install Microsoft Word and PowerPoint for previewing
translated Word and PowerPoint documents. Trados Studio also requires Microsoft
Word for spell-checking.

• Microsoft Edge WebView2. WebView 2 is most commonly used in the file Preview
functionality of Trados Studio but also in other areas of the application.

Installation location
The default installation location for Trados Studio 2024 components is:

C:\Program Files (x86)\Trados\Trados Studio

The Program Files folder on your computer may have a different name if you are using a
non- English operating system.

About the Trados Studio 2024
installation
Installing Trados Studio 2024 involves the following steps:
1. Install Trados Studio 2024 from My Account 

The installer contains a number of compressed files which Trados Studio decompresses
when you start the installation. Next, the actual installation takes place.

2. Activate Trados Studio.
Once installed, you can start Trados Studio 2024. The Product Activation dialog box is
displayed. Here you can activate your product with a perpetual or subscription license or
choose to use the 30 days trial. The trial license runs Trados Studio in Professional
mode for 30 days. At the end of 30 days you must activate your own license. If you do
not have a valid license at that time, you can no longer use Studio. If you have purchased
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a Freelance, Starter, Express or Workgroup license, you may want to take advantage of
the trial license as it will give you access to more functionality than your own license. For
more information, see the Trados Studio Editions section.

• If you downloaded the software from My Acccount > Products & Plans, go to the
location where you stored the downloaded files and run the installer from there.

• If you are installing the software from a network resource, ask your system administrator
for the network location of the Trados Studio 2024 installer setup program.

Installing Trados Studio 2024
The installation routine for Trados Studio 2024 is based on an installation wizard which
guides you through the process.

Before you begin

To install Trados Studio 2024, you must have local administrator rights on your computer.
Once you install Trados Studio, add it to the trusted programs / exclusions list of your
antivirus suite.

Note: The installer also supports administrative and silent installations. You can find
instructions for administrative and silent installations in the Trados Studio 2024 Enterprise
Deployment guide . For information on how to contact Customer Support, see
https://gateway.sdl.com .

Downloading the installer
Procedure
1. Go to My Account , select Products & Plans > Downloads.
2. Find the Trados Studio 2024 entry in the product list and select Download next to it.
3. Save the installer to a preferred location.

Running the installer
Procedure
1. Run the self-extracting installation executable file. When all of the installation files have

been decompressed, the first page of the Trados Studio 2024 installer is displayed.
2. Select Accept. The installer files are extracted to your computer. When all of the installer

files have been extracted, the License Agreement page is displayed.

Note: If you do not have Microsoft .NET Framework 4.8 installed, this is installed now
and you may be asked to restart your computer.

3. Accept the license agreement and select Next.
A screen listing all of the components that will be installed is displayed.
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4. The installer installs the components and indicates the progress of the installation.
5. When the installation is complete, a confirmation dialog is displayed. Select OK.

Trados Studio 2024 is now added to the Windows Start menu under Trados Studio
2024.

After Installation
When you first start Trados Studio, the following windows help you set up Trados Studio for
first time use: Product Activation and Trados Studio Setup Wizard.
1. The Product Activation dialog, where you can activate Trados Studio or choose to use

the 30 days trial. For more information on licensing Trados Studio, click the Help button
on this dialog or go to the Licensing Help.

2. The Trados Studio Setup wizard, where you can:
a. Specify your user details for this instance of Trados Studio.
b. Specify your user profile for this instance of Trados Studio.

Logging an Installation
The installation is logged automatically. Log files are created here:

%ALLUSERSPROFILE%\Application Data\Trados\Chainer\Logs

Software updates
Some software updates to the application can be downloaded from within Trados Studio or
software updates can be automatically checked for and downloaded when Trados Studio is
started.

You can specify how you want Trados Studio to detect application updates or your system
administrator can specify a group policy for all users.

Temporary directory
Software updates are downloaded to C:\Users\ user\ Downloads. After the update is
installed, you can delete the files from this location.
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Individual User Software Updates
An individual user of Trados Studio can do the following:

• Specify that they want to check for software updates when Trados Studio starts. They
can do this on the Automatic Updates page of the Options dialog box.

• Manually check for updates by selecting Help > Check for Updates from the ribbon in
Trados Studio.

Note: If either of these options is unavailable, the system administrator has set a group
policy that disables checking for software updates

Group Policy Software Updates
Trados Studio includes a feature that notifies users of the availability of software updates
and gives them the option to install the updates on their own computer. The system
administrator can set a group policy that controls the way this feature works. You can choose
to:

About this task

• Enable automatic checking for updates. When you choose this option, an automatic
check for updates is made every time a user starts the application. When an update is
available, the user is prompted to apply the update to their installation.

• Enable user control of checking for updates. When you choose this option, the users
can enable automatic checks for updates (these take place whenever the application is
started) and they can also check for updates manually at any time. When an update is
available, the user is prompted to apply the update to their installation.

• Disable all checks. This option means that automatic checks for updates will not be
performed and users cannot perform manual checks either. You should choose this
option if you want to control the application of updates centrally.

You define a group policy by configuring the AutoUpdate.adm file in the Group Policy dialog
box.

To define a group policy (note that the screenshots here may vary slightly, depending on the
operating system that you are using):

Procedure
1. Locate theAutoUpdate.adm file.

The default location for this file is:
%ALLUSERSPROFILE%\Package Cache\Trados\TradosStudio2024

2. Select Start > Run and enter the following command:
gpedit.msc

3. The Group Policy dialog box is displayed. Right-click on Computer Configuration >
Administrative Templates and select Add/Remove Templates from the shortcut
menu.
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4. The Add/Remove Templates dialog box is displayed. Click Add and browse to the
location of the AutoUpdate.adm file.

5. Click Close when the template is added.
6. Computer Configuration > Administrative Templates > Classic Administrative

Templates (ADM) > Applications > Trados Studio 2024 is added to the navigation tree.
Select Trados Studio to display its settings on the right.

7. Double-click on the Enable Autoupdate setting.
8. The Enable Autoupdate dialog box is displayed. Select one of the following options and

click OK to save the group policy:

• Not Configured - The user can choose to enable or disable checking for application
updates automatically when the application starts and can also manually check
for application updates.

• Enabled - Trados Studio checks for updates automatically when the application
starts. The user cannot disable the automatic updates option. The user can also
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manually check for application updates.

• Disabled - Automatic checks for application updates and manual checks for updates
are disabled. The user cannot enable either of these options.

Logging a Software Update
The update is logged automatically. There are two log files that are created.

The first log file is created when checking for updates and downloading installer for the
update. This log file is located here:

%ProgramData%\Trados\Trados Studio\Studio18\Updates

The other log file is created during the installation of the update and is located here:

%temp%\studio18updates
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Maintaining Your Installation
You can repair or remove your Trados Studio 2024 installation at any time.

Repairing your Trados Studio 2024 Installation
Use the repair feature to repair or restore missing files or registry entries in your installation.

About this task
To repair your installation:

Procedure
1. From the Start menu on your computer, select Control Panel.
2. In the Control Panel, select Programs > Uninstall a Program.
3. Right-click Trados Studio 2024 on the list of programs and select Uninstall/ Change.
4. Select Repair.

This starts the Windows Installer which runs the repair process.
5. When the process is complete, select OK.

Removing Trados Studio 2024
Before uninstalling, we recommend that you deactivate your product license. To do this, go
to Help > Product Activation in the application.

About this task
To uninstall:

Procedure
1. From the Start menu on your computer, select Control Panel.
2. In the Control Panel, select Programs > Uninstall a Program.
3. Right-click Trados Studio 2024 on the list of programs and select Uninstall/ Change.
4. Select Uninstall.

This starts the Windows Installer which runs the repair process.
5. When the process is complete, select OK.

Customer support
To contact Technical Support, connect to the Customer Support Web Portal at
https://gateway.sdl.com and log a case for your RWS product. You need an account to log a
case. If you do not have an account, contact your company's RWS Support Account
Administrator.
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What's next?
The instructions in the Trados Studio Video Help Series and the Quick Start Guides will
quickly get you started with Trados Studio.

You can access these and more helpful resources at https://docs.rws.com/TradosStudio 

If you have some existing translation resources, translation memories for example, you
should migrate them to the Trados Studio 2024 format. Converting or upgrading existing
translation resources so that you can work with them in Trados Studio 2024 is described in
the Trados Studio 2024 Migration Guide .
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Trados Studio includes open source or similar third-party software.

Autofac
Version: 4.8.1

Vendor: Autofac

Copyright: Copyright © 2015 Autofac Contributors

License type: MIT

License details: “https://github.com/autofac/Autofac/blob/v4.8.1/LICENSE”  on page 0

Azure.Core
Version: 1.38.0

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt”  on
page 0

Azure.Identity
Version: 1.11.1

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt”  on
page 0

CachedImage
Version: 1.0.1

Vendor: Hari Pachuveetil

Copyright: MIT © Haridas Pachuveetil 2014

License type: MIT

License details: “https://github.com/floydpink/CachedImage/blob/main/LICENSE”  on
page 0

ControlzEx
Version: 4.4.0

Vendor: Jan Karger, Bastian Schmidt

Copyright: Copyright © 2015 - 2020 Jan Karger, Bastian Schmidt, James Willock

License type: MIT

License details: “https://github.com/ControlzEx/ControlzEx/blob/4.4.0/LICENSE”  on page
0
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Crc32.NET
Version: 1.2.0

Vendor: force

Copyright:

License type:

License details: “https://github.com/force-net/Crc32.NET/blob/develop/LICENSE”  on
page 0

DocumentFormat.OpenXml
Version: 2.15.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/OfficeDev/Open-XML-SDK/blob/v2.15.0/LICENSE”  on
page 0

Flee
Version: 1.2.2

Vendor: Muhammet Parlak

Copyright: Copyright 2017 Muhammet Parlak

License type: L-GPL

License details: “https://github.com/mparlak/Flee”  on page 0

HtmlAgilityPack
Version: 1.11.16

Vendor: ZZZ Projects

Copyright: Copyright © ZZZ Projects Inc.

License type: MIT

License details: “https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE”
 on page 0

Hunspellx86
Version: 1.7.2

Vendor: Crawler-Lib

Copyright: Copyright (C) 2002-2017 Németh László

License type: L-GPL

License details: “https://github.com/hunspell/hunspell/blob/v1.7.2/license.hunspell”  on
page 0

3Acknowledgments

29Installation Guide



ICSharpCode.Decompiler
Version: 7.1.0.6543

Vendor: Daniel Grunwald, Siegfried Pammer

Copyright: Copyright 2011-2021 AlphaSierraPapa

License type:

License details: “https://github.com/icsharpcode/ILSpy/blob/v7.1/doc/license.txt”  on
page 0

icu.net
Version: 2.9.0

Vendor: SIL International

Copyright: Copyright © 2007-2019 SIL International

License type: MIT

License details: “https://github.com/sillsdev/icu-dotnet/blob/v2.9.0/LICENSE”  on page 0

Icu4c.Win.Full.Lib
Version: 59.1.15

Vendor: SIL International

Copyright: Copyright (c) 2016-2017 SIL International

License type: ICU

License details: “https://github.com/unicode-org/icu/blob/release-59-1/icu4c/LICENSE” 
on page 0

log4net
Version: 2.0.16

Vendor: Cincura.net, Apache.Logging

Copyright: Copyright 2004-2017 The Apache Software Foundation

License type: Apache 2.0

License details: “https://github.com/apache/logging-log4net/blob/rel/2.0.14/LICENSE”  on
page 0

MahApps.Metro
Version: 2.4.10

Vendor: Jan Karger, Dennis Daume

Copyright: Copyright © 2021 .NET Foundation and Contributors. All rights reserved.

License type: MIT

License details: “https://github.com/MahApps/MahApps.Metro/blob/2.4.10/LICENSE”  on
page 0
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Markdig.Signed
Version: 0.31.0

Vendor: Alexandre Mutel

Copyright: Copyright (c) 2018-2019, Alexandre Mutel.All rights reserved.

License type: BSD-2-Clause

License details: “https://github.com/xoofx/markdig/blob/master/license.txt”  on page 0

MaterialDesignColors
Version: 3.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE”
 on page 0

MaterialDesignThemes
Version: 5.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE”
 on page 0

MaterialDesignThemes.MahApps
Version: 1.0.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
“https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/master/LICENSE”
 on page 0

Microsoft.ApplicationInsights
Version: 2.22.0

Vendor: Microsoft

Copyright: Copyright (c) 2015 Microsoft

License type: MIT

License details:
“https://github.com/microsoft/ApplicationInsights-dotnet/blob/v2.2.0/LICENSE”  on page
0
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Microsoft.AspNet.WebApi.Client
Version: 6.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: Apache 2.0

License details:
“https://www.nuget.org/packages/Microsoft.AspNet.WebApi.Client/6.0.0/License”  on
page 0

Microsoft.AspNetCore.Connections.Abstractions
Version: 8.0.3

Vendor: Microsoft, aspnetcore

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.Http.Connections.Client
Version: 8.0.3

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.Http.Connections.Common
Version: 8.0.3

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.JsonPatch
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MS-PL

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0
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Microsoft.AspNetCore.SignalR.Client
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Client.Core
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Common
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.AspNetCore.SignalR.Protocols.Json
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.Bcl.AsyncInterfaces
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0
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Microsoft.Bcl.HashCode
Version: 1.1.1.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/main/LICENSE.TXT”  on page 0

Microsoft.Bcl.TimeProvider
Version: 8.0.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.CSharp
Version: 4.7.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.Configuration
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.Configuration.Abstraction
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0
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Microsoft.Extensions.Configuration.Binder
Version: 8.0.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

Microsoft.Extensions.DependencyInjection
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.DependencyInjection.Abstractions
Version: 8.0.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.Extensions.DependencyModel
Version: 7.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/core/blob/v7.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Features
Version: 8.0.3

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/aspnetcore/blob/v8.0.3/LICENSE.txt”  on page
0

Microsoft.Extensions.Http
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Logging
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Extensions.Logging.Abstractions
Version: 8.0.1

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.1/LICENSE.TXT”  on page 0

Microsoft.Extensions.Options
Version: 8.0.2

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.2/LICENSE.TXT”  on page 0

Microsoft.Extensions.Primitives
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

Microsoft.Identity.Client
Version: 4.60.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.60.3/LICENSE”
 on page 0
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Microsoft.Identity.Client.Extensions.Msal
Version: 4.60.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.60.3/LICENSE”
 on page 0

Microsoft.Identity.Client.NativeInterop
Version: 0.16.0

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “”  on page 0

Microsoft.IdentityModel.Abstractions
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.IdentityModel.JsonWebTokens
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.IdentityModel.Logging
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0
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Microsoft.IdentityModel.Tokens
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/dev/LICENSE.txt”
 on page 0

Microsoft.Office.Interop.Outlook
Version: 15.0.4797.1004

Vendor: Camron Bute

Copyright:

License type:

License details: “”  on page 0

Microsoft.Office.Interop.Word
Version: 15.0.4797.1004

Vendor: Camron Bute

Copyright:

License type:

License details: “”  on page 0

Microsoft.Web.WebView2
Version: 1.0.2210.55

Vendor: Microsoft, webview

Copyright: © Microsoft Corporation. All rights reserved.

License type:

License details:
“https://www.nuget.org/packages/Microsoft.Web.WebView2/1.0.2210.55/License”  on
page 0

Microsoft.Xaml.Behaviors.Wpf
Version: 1.1.77

Vendor: Microsoft, xamlexperiencesteam

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/microsoft/XamlBehaviorsWpf/blob/v1.1.77/LICENSE” 
on page 0
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murmurhash-signed
Version: 1.0.2

Vendor: Darren Kopp

Copyright: Copyright © 2021 The Apache Software Foundation, Licensed under the Apache
License, Version 2.0.

License type: Apache 2.0

License details:
“https://github.com/darrenkopp/murmurhash-net/blob/master/LICENSE.md”  on page 0

NETStandard.Library
Version: 2.0.3.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT”  on page
0

Newtonsoft.Json
Version: 13.0.3

Vendor: James Newton-King

Copyright: Copyright (c) 2007 James Newton-King

License type: MIT

License details:
“https://raw.githubusercontent.com/JamesNK/Newtonsoft.Json/master/LICENSE.md”  on
page 0

Nlog
Version: 4.6.7

Vendor: Jarek Kowalski, Kim Christensen, Julian Verdurmen

Copyright: Copyright (c) 2004-2020 NLog Project - https://nlog-project.org/

License type: BSD-3-Clause

License details: “https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt”  on page 0

Sdl.MultiSelectComboBox
Version: 1.0.77

Vendor: RWS

Copyright: Copyright © RWS

License type: Apache 2.0

License details: “https://github.com/RWS/Multiselect-ComboBox/blob/master/LICENSE” 
on page 0
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Sharpcompress
Version: 0.36.0

Vendor: Adam Hathcock

Copyright: Copyright (c) 2014 Adam Hathcock

License type: MIT

License details:
“https://github.com/adamhathcock/sharpcompress/blob/0.36.0/LICENSE.txt”  on page 0

SharpZipLib
Version: 1.4.1.0

Vendor: ICSharpCode

Copyright: Copyright © 2000-2018 SharpZipLib Contributors

License type: MIT

License details: “https://github.com/icsharpcode/SharpZipLib/blob/v1.4.1/LICENSE.txt” 
on page 0

SimpleInjector
Version: 5.4.4

Vendor: Simple Injector Contributors

Copyright: Simple Injector Contributors 2010 - 2020

License type: MIT

License details: “https://github.com/simpleinjector/SimpleInjector/blob/v5.4.4/LICENSE” 
on page 0

SmartThreadPool
Version: 2.3.0

Vendor: Ami Bar

Copyright: Copyright © Ami Bar

License type: MS-PL

License details: “https://github.com/amibar/SmartThreadPool/blob/v2.3.0/LICENSE”  on
page 0

System.Buffers
Version: 4.5.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0
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System.Collections.Immutable
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.IdentityModel.Tokens.Jwt
Version: 7.4.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details:
“https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/7.4.1/LICENSE.txt”
 on page 0

System.IO.Abstractions
Version: 4.2.17

Vendor: Tatham Oddie

Copyright: Copyright © Tatham Oddie 2010

License type: MIT

License details:
“https://github.com/System-IO-Abstractions/System.IO.Abstractions/blob/main/LICENSE”
 on page 0

System.IO.Pipelines
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Memory
Version: 4.5.5

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en/dotnet_library_license.htm”  on page 0
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System.Net.Http
Version: 4.3.4

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en-us/dotnet_library_license.htm”  on page
0

System.Numerics.Vectors
Version: 4.5.0

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://dotnet.microsoft.com/en/dotnet_library_license.htm”  on page 0

System.Reactive
Version: 6.0.0

Vendor: .NET Foundation and Contributors

Copyright: Copyright (c) .NET Foundation and Contributors.

License type: MIT

License details: “https://github.com/dotnet/reactive/blob/rxnet-v6.0.0/LICENSE”  on page
0

System.Reflection.Metadata
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright:

License type:

License details: “https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT”  on page 0

System.Reflection.TypeExtensions
Version: 4.7.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0

System.Runtime.CompilerServices.Unsafe
Version: 6.0.0

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: “https://github.com/dotnet/runtime/blob/master/LICENSE.TXT”  on page
0

System.Text.Encoding.CodePages
Version: 8.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Text.Encodings.Web
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Text.Json
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Threading.RateLimiting
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

System.Threading.Channels
Version: 8.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/runtime/blob/v8.0.0/LICENSE.TXT”  on page 0

3Acknowledgments

43Installation Guide



System.Threading.Tasks.Extensions
Version: 4.5.4

Vendor: Microsoft

Copyright: Copyright © Microsoft Corporation. All rights reserved.

License type: MIT

License details: “https://github.com/dotnet/corefx/blob/master/LICENSE.TXT”  on page 0

YamlDotNet
Version: 8.1.0

Vendor: Antoine Aubry

Copyright: Copyright (c) 2008, 2009, 2010, 2011, 2012, 2013, 2014 Antoine Aubry and
contributors

License type: MIT

License details: “https://github.com/aaubry/YamlDotNet/blob/v8.1.0/LICENSE.txt”  on
page 0

ZstdSharp.Port
Version: 0.7.4

Vendor: oleg-st

Copyright: Copyright Oleg Stepanischev 2024

License type: MIT

License details: “https://github.com/oleg-st/ZstdSharp/blob/0.7.4/LICENSE”  on page 0
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